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Dell™ 2-2-1 solution + virtualization:
Replace all your old servers

Virtualization benefits you by allowing you to consolidate your physical servers and

manage your infrastructure from a single location. But can virtualized servers deliver the same
performance you’ve been getting by running applications on your multiple physical servers?

The answer is yes—assuming you have the right equipment. Dell™ Inc. created 2-2-1
solutions for businesses like yours—offering a flexible, highly available infrastructure that gives
you the performance you need while maintaining room for future growth. To put this to the
test, we consolidated four older servers running common business applications, along with a
management virtual machine, onto the Dell 2-2-1 solution.

The Dell 2-2-1 solution could handle the needs of users and them some: Running five
virtual machines (VMs) did not overload its two Dell PowerEdge™ servers. In fact, sufficient
resources remained to support additional VMs in the future and to handle a complete server
failover—that’s when one server goes down and the other server takes on its workload until the
first server is restored.

To learn more about how we tested the performance capabilities of the Dell 2-2-1
solution, continue reading. If you’d like to learn more about how virtualizing with Dell 2-2-1
solutions can benefit your business, click the tabs at the top of this page to view the other

reports in this series (the Benefits video and study are especially helpful places to begin).
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MEET YOUR PERFORMANCE NEEDS WITH FEWER SERVERS

Reducing the number of servers your business requires is a great way to
improve efficiency and save money. Thanks to virtualization, one new physical server
can run multiple applications, each on its own virtual machine, while still providing good
performance and offering headroom to spare. Adding a second server, a storage array,
and switches to connect the components ensures that your configuration has no single
point of failure—this means that your system stays running at all times. If a server goes
down, the VMs and applications running on it fail over to the other server and resume
running after only a slight interruption, maintaining a near-seamless experience for your
users.

We took older servers already running common Microsoft® business
applications, including email (Exchange Server 2010), financial and operations
management (Dynamics® GP 2010), database (SQL Server® 2008 R2), and collaboration
(SharePoint® Server 2010), and consolidated them into VMs on two Dell PowerEdge
R410 servers running Windows Server® 2008 R2 Hyper-V™. We also created a fifth VM
as a management server, which ran Microsoft System Center Essentials 2010.

We tested the performance of each VM on the Dell PowerEdge R410 servers by
simulating increasing numbers of users (from 25 to 75 to 125) simultaneously accessing
the database, using email, and using SharePoint. Our findings? Not only could the two
PowerEdge R410 servers run these heavy workloads, but they had plenty of resources,

such as CPU and memory, to spare for future growth.
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Dell PowerVault MD3200i storage array

Figure 1: Dell 2-2-1 solution, built on Dell PowerEdge R410 servers, runs your business applications with the performance you
need, while providing room for growing your business in the future.
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HEADROOM FOR FUTURE GROWTH AND HIGH AVAILABILITY

WHAT WE FOUND

As you add new customers, hire new employees, run new applications, and
otherwise expand your business, you rely on your servers to keep up. By investing wisely
in today’s servers, you can meet these future challenges without having to spend more
on additional servers and the storage, electricity, and IT management time they require.

A well-designed virtualization solution includes redundancy to ensure your
crucial data remains available no matter what. Data loss or unavailability due to server
failure or maintenance can be expensive, disrupting your business and possibly driving
away customers.

The Dell 2-2-1 solution we tested comprised two Dell PowerEdge R410 servers,
two Dell PowerConnect™ 5524 switches, and one Dell PowerVault™ MD3200i storage
array. Together, they form a failover cluster—a group of components configured to
move the VMs from a failed server to the redundant server, where they soon resume
working.

We used Hyper-V VMs to host two business applications and one management
server application on one Dell PowerEdge R410 server and the other two business
applications on the other Dell PowerEdge R410 server.

To simulate a failure on the first server, we removed its power supply. The two
VMs on that server failed over seamlessly and began running on the other Dell
PowerEdge R410 with minimal downtime of 2.5 minutes.

Both Dell PowerEdge R410 servers had sufficient headroom that they could
easily run not only their own two or three VMs but also those VMs originally hosted by
the other PowerEdge R410 server, for a total of five VMs. Had we removed the power
supply from the second server instead of the first, the cluster would have failed over the
other way—the three VMs from the second server would have moved to the first server.

We wanted to verify that the Dell 2-2-1 solution could handle a workload
simulating varying numbers of users—25, 75, or 125—in the VMs. To maintain high
availability, each Dell PowerEdge R410 server had to handle the full workload of five
VMs without overcommitting resources (i.e., not being able to run all VMs); this would
allow each server to serve as backup for the other server in the event that it failed.

We chose workloads for the SQL Server, Exchange Server, and SharePoint Server
VMs that would effectively test the capability of the Dell 2-2-1 solution to support up to
125 users on each application. Figure 2 shows the benchmark we used to test each VM
and the median result, in either orders per minute (OPM) or in a PASS/FAIL rating, of
three runs for each. For the DVD Store OPM scores, we determined a passing score to
be 80, 224, and 400 OPM for the 25, 75, and 125-user workloads, respectively. Note that

we did not conduct benchmark testing of Dynamics GP 2010 or the management server,
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but we did verify that the failover cluster was allocating the necessary hardware

resources to run these VMs successfully.

VM Benchmark 25-user test 75-user test 125-user test

SQL Server 2008 R2 VM DVD Store Version 2 99 OPM 293 OPM 495 OPM
Microsoft Exchange

Exchange Server 2010 VM Load Generator 2010 PASS PASS PASS
(LoadGen)

SharePoint Server 2010 VM | WSSDW 1.0.0.0 Beta PASS PASS PASS

Figure 2: Median benchmark test results. OPM is orders per minute, the metric that DVD Store uses to report performance.

Both servers were able to handle the load while maintaining resource usage
standards for high availability, with room for future growth. The workloads, tweaked to
simulate the average demands of each user number, used only a fraction of the
processing power available, leaving ample capacity to handle, for example, a sudden
spike in usage for any or all of these applications. Figure 3 shows the average resource
utilization for the servers from each median run, demonstrating that the servers and

storage had plenty of resources left over. Lower numbers are better.

Average percentage Average percentage
CPU utilization memory utilization

25-user test
Hyper-V Host 1 2.09% 50%
Hyper-V Host 2 2.18% 33%
75-user test
Hyper-V Host 1 1.83% 50%
Hyper-V Host 2 2.79% 33%
125-user test
Hyper-V Host 1 2.55% 50%
Hyper-V Host 2 2.72% 33%

Figure 3: Resource utilization for the two Dell PowerEdge R410 Hyper-V host servers. Lower numbers are better.

The PowerVault MD3200i storage array could support the heavy workloads
needed to run all the business applications and the management server, with storage
capacity left for future growth. Figure 4 shows the capacity of the storage array during
our tests. Even with the storage configured in a RAID 10, which offers the smallest total
capacity but allows for mirroring and maximum 1/O performance, we still had 44.1
percent of the total storage capacity available to allocate for additional application VMs

or extra storage volumes.
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Storage capacity
Total capacity 2,791 GB
Used/configured 1,560 GB
Unused/available 1,231 GB
Percentage of available space 44.1%

Figure 4: Storage capacity for the Dell PowerVault MD3200i storage array during our tests.

We also tested the failover capabilities of the Dell 2-2-1 solution by causing one
of the servers to fail while running the 125-user workload. Our results indicate that a
single PowerEdge R410 server could run all five VMs while still providing the same level
of performance as when it ran only two or three VMs. As Figure 5 shows, the Dell 2-2-1
solution soon detected the failure of this server and automatically moved the three VMs
to the other server, which kept the workloads running with only a brief downtime for
users. Furthermore, the single redundant Dell PowerEdge R410 server was able to run
all five VMs under workload stress with acceptable CPU and RAM resource utilization.

Failover results

Downtime 2 minutes 30 seconds
CPU usage on single redundant server post-failover 9.55%
RAM usage on single redundant server post-failover 75.50%

Figure 5: Median failover results for the single redundant Dell PowerEdge R410 server, post-failover. Lower numbers are better.

WHAT WE TESTED

Database testing

We tested the ability of the Dell 2-2-1 solution to handle up to 125 users
simultaneously accessing the following applications: a collaboration server running
Microsoft SharePoint Server, a mail server running Microsoft Exchange Server, and a
database server running Microsoft SQL Server. We ran the workloads on the VMs for 30
minutes simultaneously. We measured average resource utilization during the last 5
minutes of the test when all benchmarks had ramped up to maximum resource
utilization. We report the median of three runs.

To learn more about how we tested, see Appendix B.

To test the SQL Server 2008 VM, we used the DVD Store Version 2 (DS2)
benchmark to simulate database users. DS2 is an open-source application that models
an online DVD Store. Customers log in, and then browse and purchase movies. DS2 uses
a results metric of orders per minute that the server can handle.

We ran DS2 with a 3-second think time and modified the number of threads to
simulate the number of users, 5 threads for 25 users, 15 threads for 75 users, and 25

threads for 125 users. Each thread represented five users completing one order
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Mail testing

Collaboration testing

approximately every 15 seconds. DS2 then uses a default value of three searches on

average before each order. We define a minimum acceptable score as 80 OPM for 25

users, 224 OPM for 75 users, and 400 OPM for 125 users, which is 80 percent of the

expected results (80 percent of 4 OPM times the number of users), to account for

variation in the number of searches the benchmark completed prior to each order.
To learn more about DS2, see

http://www.delltechcenter.com/page/DVD+Store.

To test the mail server performance of the Dell 2-2-1 solution, we used the
Microsoft Load Generator 2010 (LoadGen) benchmark, which performs tasks to simulate
a standard user generating mail activity. We simulated 25, 75, or 125 users and used the
following settings:

e Mailbox Profile: 100MB mailboxes
e Action Profile: Average
e Client Type: Outlook 2007 Cached

LoadGen simulates the mail activity for the 25, 75, or 125 users. It then reports a
PASS/FAIL rating, which is based on acceptable response times.

To learn more about LoadGen, visit
http://www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-4D66-
A82F-8D3062C6FA98&displaylang=en.

To simulate the traffic of SharePoint Server 2010 users, we used the SharePoint
2007 Test Data Load Tool 1.0.0.0 Beta test. This test creates sample data, populates the
server with it, and simulates SharePoint Server users completing everyday tasks.

We used Microsoft Visual Studio® 2010 to execute the test workload,
generating a realistic user workload. In it, each of the simulated users performed a task
every 3 minutes. To accomplish this, we configured the test to run 25, 75, and 125 users
with a 3-minute think time in between each of the various tasks. The test workload then
reports a PASS/FAIL rating based on whether it was able to complete all of the tasks
successfully.

To read more about SharePoint Server, see http://office.microsoft.com/en-

us/sharepoint-server-help/.
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CONCLUSION

The Dell 2-2-1 solution is an excellent choice for a virtualized server solution. As
our tests results indicate, its redundant Dell PowerEdge R410 servers provide a
combination of performance, headroom, high availability, and failover capability that
you need to confidently move your applications onto virtual machines while supporting
as many as 125 users.

As we detail in our other reports, virtualizing your servers on the Dell 2-2-1
solution can also save you considerable time and money, and configuring it is a simple

process.
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APPENDIX A — SERVER AND STORAGE CONFIGURATION INFORMATION

Figures 6 through 8 provide configuration information for the components of the Dell 2-2-1 solution.

System

Dell PowerEdge R410s

Power supplies

Total number 2

Vendor and model number Dell D500E-SO
Wattage of each (W) 500

Cooling fans

Total number 6

Vendor and model number San Ace 40 9CRD412P5K05
Dimensions (h x w) of each 2.25"” x 1.50”
Volts 12

Amps 1.2A

General

Number of processor packages 2

Number of cores per processor 4

Number of hardware threads per core 8

System power management policy

Active Power Controller

CPU

Vendor Intel
Name Xeon
Model number E5630
Stepping B1

Socket type 1366 FCLGA
Core frequency (GHz) 2.53 GHz
Bus frequency 5.86 GT/s
L1 cache 4x32KB
L2 cache 4 x 256 KB
L3 cache 12 MB
Platform

Vendor and model number

Dell PowerEdge R410

Motherboard model number

Dell Inc. 01V648

BIOS name and version

Dell Inc. 1.6.3 (02/07/2011)

BIOS settings

Virtualization and RAID mode enabled

Memory module(s)

Total RAM in system (GB)

24

Vendor and model number

Samsung M393B5273CH9-YH9

Type

PC3L-10600R

Speed (MHz) 1,333
Speed running in the system (MHz) 1,067
Timing/Latency (tCL-tRCD-tRP-tRASmin) 7-7-7-20
Size (GB) 4
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System Dell PowerEdge R410s
Number of RAM module(s) 6

Chip organization Double-sided

Rank Dual

Operating system

Name Windows Server 2008 R2 SP1 Enterprise Edition
Build number 7601

File system NTFS

Kernel ACPI x64-based PC

Language English

Graphics

Vendor and model number

Standard VGA Graphics Adapter

Graphics memory (MB)

8

Driver

Microsoft 6.1.7600.16385 (6/21/2006)

RAID controller

Vendor and model number PERC S100

Firmware version 2.0.0-0162

Driver version Dell Inc. 2.0.0.162 (1/10/2011)
Cache size (MB) N/A

Hard drives

Vendor and model number

Dell WD2502ABYS-18B7A0

Number of drives 2
Size (GB) 250
RPM 7,200
Type SATA
Ethernet adapters

Network adapter #1

Vendor and model number

Broadcom® BCM5716C NetXtreme® |

Type Integrated

Driver Microsoft 4.8.4.1 (12/23/2008)

Network adapter #2

Vendor and model number Intel Gigabit ET Quad Port Server Adapter
Type PCI-E

Driver Intel 11.11.43.0 (9/1/2011)

Optical drive(s)

Vendor and model number

TEAC DVD-ROM DV-285W

Type DVD/CD-ROM
USB ports

Number 4

Type 2.0

Figure 6: Configuration information for our test servers.
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Storage array

Dell PowerVault MD3200i

Vendor and model number

Dell PowerVault MD3200i

Type iSCSI
Number of storage controllers 2

Number of iSCSI ports per controller 4

Firmware Revision 07.70.06.63
RAID level 10

First type of drive

Vendor and model number

Dell STSOONMO0001

Number of drives 8

Size (GB) 500

RPM 7,200

Type NL-SAS

Second type of drive

Vendor and model number Dell ST3500414SS
Number of drives 4

Size (GB) 500

RPM 7,200

Type NL-SAS

Figure 7: Detailed configuration information for the storage array.

Network switches

Dell PowerConnect 5524

Vendor and model number

Dell PowerConnect 5524

Number of ports

24

Firmware revision

4.0.0.3

Figure 8: Detailed configuration information for the network switches.
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APPENDIX B— HOW WE TESTED

Figure 9 shows the network cabling we recommend for a high-availability setup. For our existing infrastructure
connections into the public and VM network, we used a Dell PowerConnect 5548 switch.

Dell PowerEdge R410

Dell PowerConnect 5524 Dell PowerCon nect 5524

—e Public + VM network [TU—‘
iSCSI network o S====== =
o 103 | S M I L Il J,— oy ) : 0
—a Live Migration network ‘E—Q : B® $ g Existing
—e Private/CSV network — u-—ﬁi"usjl_\—/ L | infrastructure
—e Stacking connections =i L ® .

Dell PowerVault MD3200i

Figure 9: Our test bed setup.

We implemented stacking on the two Dell PowerConnect 5524 high-performance switches to provide ample
connectivity between the switches. Figure 10 shows how we configured the network cables across the NICs for each Dell
PowerEdge R410.

NIC Port number Traffic type
1 Private/CSV
Integrated on-board NIC 2 iSCSI #1
1 iSCSI #2
o 2 Live Migration
Intel Gigabit Quad port 3 Public/VM #1
4 Public/VM #2

Figure 10: NIC port configurations for each Dell PowerEdge R410.
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We used a serial connection to access the basic setup wizard on the switches to configure an administrator
password and change the IP address to match our IP scheme. Figure 11 provides details on the IP scheme we used in our
testing.

Subnet Traffic type Adapters assigned to this subnet

192.168.130.0
192.168.131.0

192.168.132.0 iSCSI iSCS| adapters

192.168.133.0

192.168.1.0 Public/VM Yirtual machines, storage management, Hyper-V host servers,
infrastructure server, and iDRAC management

192.20.1.0 Private/CSV Private and cluster shared volumes adapters

192.30.1.0 Live Migration Live Migration adapters

Figure 11: The IP scheme we used.

Figure 12 shows how we configured VLANSs in the Dell PowerConnect 5524 switches to isolate the different types
of network traffic.

VLAN ID Traffic type Ports assigned to this VLAN

10 iSCs| iSCSI traffic ports from storage and servers (for this setup, there are
twelve)

20 Private/CSV Private/CSV ports (for this setup, there are two)

30 Live Migration Live Migration ports (for this setup, there are two)

Figure 12: VLAN configuration.

We staggered the benchmark start times with 2 minutes between each benchmark, with DVD Store beginning
first, then WSSDW 1.0.0.0 Beta, then Load Generator, and allowed them to run simultaneously for 30 minutes. Between
tests, we restored the Mailbox and Public Folder stores by temporarily dismounting them and restoring them from a
backup. We used a script to restore the DVD Store database, which dropped the existing database and restored it from
the backup.

Starting DVD Store

We created a batch file to run the following parameters to begin the DVD Store test. We used the following
parameters in the batch file for testing the virtual machine (showing the 75-user configuration):

ds2sglserverdriver.exe --target=192.168.1.2 --ramp rate=10 --run time=30 --
n threads=15 --db size=5gb --think time=3 -detailed view=y

1. Restart the DVD Store client and the virtual machine.
2. Openacommand prompt, and navigate to the location of the batch file.
3. Start the performance monitor counters, and kick off the batch file.

Starting LoadGen

1. Restart the mail client and the virtual machine.
2. Start Exchange Load Generator 2010, and load the configuration file.
3. Verify the test simulation settings, and start the performance monitor counters.
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4. To start the test, select the option to skip the initialization phase, and begin the simulation.

Starting WSSDW 1.0.0.0 Beta

1. Restart the virtual machine.
2. Open the benchmark file in Visual Studio.
3. Start the performance monitor, select the simulation, and click Run test.

Configuring the database (DVD Store)

Data generation overview

We built the database schema using the scripts in the DS2 distribution package, though we made a few minor
modifications. The DS2 stress tool provides options to generate 10MB, 1GB, or 100GB datasets. To get the tool to
generate the 5 GB of user data we used in this test, we had to make a few straightforward changes to the source code
and to the DVD Store application’s scripts. Note: We created our test data on a Linux system to take advantage of the
larger RAND MAX.

Generating the data for the 5GB database

We used shell scripts to run all four of the executables that generate the data. The distribution did not include
shell scripts for the 5GB size. We wrote shell scripts based on the ds2_create_cust_large.sh and
ds2_create_orders_large.sh scripts. The ds2_create_prod and ds2_create_inv executables did not ship with associated
shell scripts, so we created shell scripts using the instructions in the readme files. We ran the shell scripts in the
following order to generate the data for the 5GB database:

1. ds2 create orders 5gb.sh
2. ds2 create inv 5gb.sh

3. ds2 create prod 5gb.sh

4. ds2 create cust 5gb.sh

We waited until the processes finished before we moved onto the next step.

Creating the database

We modified the database creation SQL Server scripts in the DVD Store distribution package to build the
database schema, which includes the file structure, tables, indices, stored procedures, triggers, and so on. We built the
5GB database in SQL Server 2008 R2, and then performed a full backup, storing the backup file on the C: drive for quick
access.

Setting up the infrastructure server
To provide an existing hardware infrastructure for our Dell 2-2-1 solution hardware, we prepared a Dell
PowerEdge T110 to serve as our Active Directory and DNS server by installing a fresh copy of Windows Server 2008 R2
SP1 Enterprise Edition, and installing the Active Directory Domain Services, DNS, and the Active Directory Certificate
Services role.
1. Set a static IP address using the following steps:
a. Right-click the network icon in the quick-launch bar, and choose Network and Sharing Center.
Click Manage network connections.
Right-click the local area connection, and choose Properties.
Select Internet Protocol Version (TCP/IPv4), and click Properties.

Select the Use the following IP address radio button, and type 192.168.1.1 inthe IP address field.
Press Tab to auto-fill 255.255.248.0 in the Subnet mask field.

-0 ooo
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g. Click Close.
2. Give the system a name using the following steps:
Click Start, right-click Computer, and select Properties.
Click Change Settings.
Click Change.
Type adserver in the Computer name field, and click OK.
In the Computer Name/Domain Changes pop-up window, click OK.
Click OK.
g. Inthe Microsoft pop-up window, click Restart Now.
3. Promote the mail server to domain controller by following these steps:
a. Select Start>Command Prompt.
Type dcpromo
At the Welcome pop-up window, click Next.
At the Operating System Compatibility screen, click Next.
At the Choose a Deployment Configuration screen, select the Create a new domain in a new forest radio
button, and click Next.
At the Name the Forest Root Domain screen, type the domain name cezanne.com and click Next.
g. Atthe Set Forest Functional Level screen, choose Windows Server 2008 R2 from the drop-down menu,
and click Next.
h. At the Set Domain Functional Level screen, choose Windows Server 2008 R2 from the drop-down menu,
and click Next.
At the Additional Domain Controller Options screen, accept the defaults, and click Next.
When the Active Directory domain Services Installation Wizard window pops up, click Yes.
At the Location for Database, Log Files, and SYSVOL screen, click Next.
At the Directory Services Restore Mode Administrator Password screen, enter a password, and click
Next.
m. At the Summary screen, review the selections, and click Next.
n. At the Completing the Active Directory Installation Wizard screen, click Finish.
0. When the system prompts you to reboot the server, click Restart Now.
p. After the server reboots, log into the system.

"o oo T o
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Creating the tester user

1. Select Start->All Programs—>Administrative Tools=> Active Directory Users and Computers.

2. Inthe Active Directory Users and Computers window, select the server in the left pane, and open Users in the

right pane.

Right-click a blank area in the Users folder, and select New—> User.

In the New Object - User window, complete the name fields as you wish (we used first name: test, last name:

tester, logon name: tester), and select Next.

Enter a secure password (we used Password1), and check Password never expires.

In the pop-up information window, click Accept.

Select Next to close the New Object — User window.

Double-click the new user to bring up the Properties window.

Under the Member Of tab, click Add.

10. In the Enter the object names to select dialog box, type Domain Admins; Enterprise Admins;
Organization Management select Check Names to verify, and click OK.

11. Click OK to close the User Properties window, and close the Active Directory Users and Computers window.

pw
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Configuring the legacy physical servers

We installed Windows Server 2008 R2 SP1 Enterprise Edition on all of the legacy servers. Following the operating

system installation, we installed all important Windows updates as of 9/30/2011. We also disabled Windows Firewall on

all servers and assigned IP addresses to the NICs.

Preparing the SQL Server 2008 R2 legacy server
Installing Windows Server 2008 R2 SP1 Enterprise Edition

=
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Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms check box, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Click Start, type change power-saving settings and press Enter.
. Click Change plan settings.

. Change the Turn off the display drop-down menu to Never.

14.

Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

Installing Microsoft SQL Server 2008 R2

1.
2.

oukWw
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11.
12.

13.
14.
15.
16.

17.
18.
19.

Insert the installation DVD for SQL Server 2008 R2 into the DVD drive.

Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2008 R2 DVD, and
double-click.

If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
In the left pane, click Installation.

Click New installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant warnings,
click OK.

Select the Enter the product key radio button, and enter the product key. Click Next.

Click the checkbox to accept the license terms, and click Next.

Click Install to install the setup support files.

. If there are no failures displayed, click Next. You may see a Computer domain controller warning and a Windows

Firewall warning. For now, ignore these.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select Database Engine Services, Full-Text Search, Client Tools Connectivity,
Client Tools Backwards Compatibility, Management Tools —Basic, and Management Tools — Complete. Click Next.
At the Installation Rules screen, click Next once the check completes.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Disk space requirements screen, click Next.

At the Server configuration screen, choose NT AUTHORITY\SYSTEM for SQL Server Agent, and choose NT
AUTHORITY\SYSTEM for SQL Server Database Engine. Click Next.

At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.
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20.
21.
22.

23.
24,
25.
26.

27.

28.
29.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Next.

Click Close.

Place the DVD Store backup file you prepared in the default location for SQL Server: C:\Program Files\Microsoft
SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Backup.

Click Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration Tools, and click SQL Server
Configuration Manager.

Expand SQL Server Network Configuration, and click Protocols for MSSQLSERVER.

Right-click TCP/IP, and select Enable.

Preparing the Exchange Server 2010 legacy server
Installing Windows Server 2008 R2 SP1 Enterprise Edition

=
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Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms check box, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Click Start, type change power-saving settings and press Enter.
. Click Change plan settings.

. Change the Turn off the display drop-down menu to Never.

14.

Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

Installing .NET Framework 3.5.1 Features and Internet Information Services

1.

PN~ WN

9.

10.

Select Start—>Administrative Tools=>Server Manager.

Click Features.

Click Add Features.

Select .NET Framework 3.5.1 Features, and click Install.

Click Add Required Role Services.

Click Next.

Click Next.

At the Select Role Services screen, select the 1IS 6 Metabase Compatibility, IIS 6 Management Console, Basic
Authentication, Windows Authentication, Digest Authentication, and Dynamic content Compression checkboxes,
and click Next.

At the Confirm Installation Selections screen, click Install.

At the Installation Results screen, click Close.

Installing Microsoft Filter Pack 2.0

1.

2.

Download the Microsoft Filter Pack 2.0.
(http://www.microsoft.com/downloads/en/details.aspx?FamilylD=5cd4dcd7-d3e6-4970-875e-aba93459fbee)
Run FilterPackx64.EXE.
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3. Click Next.
4. Click | accept the terms in the License Agreement, and click Next.
5. When the installation is complete, click OK.

Installing Exchange Server 2010

=

Click Start, type services and press Enter.
Right-click the Net.Tcp Port Sharing service, and click Properties.
Change the Net.Tcp Port Sharing startup type to Automatic, and click OK.
Insert the installation DVD, and click Setup.EXE when prompted.
Select a folder to extract the installation files to, and click OK.
Run Setup.EXE.
The installer should consider steps 1 and 2 complete, and gray them out.
Click the link to Step 3: Choose Exchange Language Option.
Click Install only languages from the DVD.
. Click the link to Step 4: Install Microsoft Exchange Server 2010 SP1.
. Click Next to go past the introduction screen.
. Accept the license agreement, and click Next.
. Select No for error reporting, and click Next.
. Select Custom Exchange Server Installation, and click Next.
. Select Mailbox, Client Access Services, and Hub Transport (Exchange will automatically select Exchange
Management Tools as well), and click Add mailbox.
16. Leave the organization name at default (First Organization), and click Next.
17. At the question about client computers running Outlook 2003 and earlier, select Yes, and click Next.
18. Click Next to accept defaults for Configure Client Access server external domain.
19. At the Customer Experience Improvement Program screen, select | don’t wish to join the program at this time,
and click Next.
20. If a warning about a lack of SMTP appears after the check finishes, ignore it.
21. Click Install to start the installation process.
22. Once installation is complete, click Finish. Exchange should automatically open the Exchange Management
Console.
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Configuring Exchange Server 2010 roles

1. If Exchange does not automatically open the Exchange Management Console, select Start>All
Programs—>Microsoft Exchange Server 2010->Exchange Management Console.

In the left pane, click Microsoft Exchange On-Premises.

In the left pane, expand Organization Configuration, and select Hub Transport.

In the action pane on the far right, select New Send Connector.

Name the send connector SMTP select the intended use as Internet, and click Next.

In the Address space window, click Add.

In the SMTP Address Space window, type * as the address, ensure that the installer has checked Include all
subdomains, and click OK.

8. Click Next.

9. Accept defaults for the next two pages by clicking Next.

10. At the New Connector page, click New to create the connector.

11. Click Finish to close the New SMTP Send Connector wizard.

NoukwnN

Configuring the Exchange Server 2010 Mailbox role
1. Select Start—>All Programs—>Microsoft Exchange Server 2010 Exchange Management Console.
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8.
9.

10.
11.
12.

13.
14.
15.
16.
17.
18.
19.
20.
21.
22.

23.
24,
25.
26.
27.
28.
29.
30.
31.
32.
33.

34.
35.

In the left pane of the Exchange Management Console window, select Recipient Configuration; in the right pane,
select New Mailbox.

In the New Mailbox window, select User Mailbox, and click Next.

In the User Type page, select Existing users, and click Add.

Select the new account you created earlier, and click OK to add it to the selection box.

Click Next.

In the Mailbox Settings window, type tester in the Alias textbox, check the box beside Specify the mailbox
database rather than using a database automatically selected, and select Browse in the Mailbox database
selection.

In the Select Mailbox database window, select Mailbox Database, and click OK.

Click Next.

Click Next.

Click Finish.

In the left pane, expand Organization Configuration and Mailbox so that the Database Management tab is
visible.

Right-click Mailbox Database, and select Properties.

Select the Maintenance tab.

Check the Enable circular logging box.

Check the box beside This database can be overwritten by a restore.

Click Customize next to Maintenance interval.

Remove all blue from the boxes so the system will not perform maintenance, and click OK.

Click OK.

Click OK to any warnings about circular logging being applied after the database is remounted.

On the far right panel, click Move Databases.

Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Maillogs respectively,
and click Move.

If the application prompts you to dismount, click Yes.

Click Finish.

Right-click Public Folder Database, and select Properties.

Check the Enable circular logging checkbox.

Check the This database can be overwritten by a restore checkbox.

Click Customize next to Maintenance interval.

Remove all blue from the boxes so the system will not perform maintenance, and click OK.

Click OK.

On any warnings about circular logging being applied after the database is remounted, click OK.

Click Move Database on the far right panel.

Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Publiclogs respectively,
and click Move.

If the application prompts you to dismount, click Yes.

Click Finish.

Preparing the SharePoint Server 2010 Legacy server
Installing Windows Server 2008 R2 SP1 Enterprise Edition

1.

ukhwnN

Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms check box, and click Next.
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6. Click Custom.

7. Click Next.

8. At the User’s password must be changed before logging on warning screen, click OK.

9. Enter the desired password for the administrator in both fields, and click the arrow to continue.

10. At the Your password has been changed screen, click OK.

11. Click Start, type change power-saving settings and press Enter.

12. Click Change plan settings.

13. Change the Turn off the display drop-down menu to Never.

14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

Installing SharePoint Server 2010

1. Insert the installation DVD, and capture the DVD drive in the VM session.

2. Launch setup.exe, and click Install software prerequisites.

3. At the Welcome to the Microsoft SharePoint 2010 Products Preparation Tool screen, click Next.

4. Accept the EULA, and click Next.

5. When the prerequisites finish installing, click Finish.

6. On the main SharePoint installation menu, click Install SharePoint Server.

7. Enter your product license key, and click Continue.

8. Accept the EULA, and click Continue.

9. Choose the Stand-Alone server type, and click Install.

10. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and

click Close.
11. On the Welcome to SharePoint Products screen, click Next.
12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
13. When the wizard has completed the configuration, click Finish.

Preparing the Dynamics GP server
Installing Windows Server 2008 R2 SP1 Enterprise Edition

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. Atthe Language Selection Screen, click Next.

3. Click Install Now.

4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

5. Click the | accept the license terms check box, and click Next.

6. Click Custom.

7. Click Next.

8. Atthe User’s password must be changed before logging on warning screen, click OK.

9. Enter the desired password for the administrator in both fields, and click the arrow to continue.
10. At the Your password has been changed screen, click OK.

11. Click Start, type change power-saving settings and press Enter.

12. Click Change plan settings.

13. Change the Turn off the display drop-down menu to Never.

14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.
Installing SQL Server 2008 R2
1. Insert the installation DVD for SQL Server 2008 R2 into the DVD drive.
2. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2008 R2 DVD, and
double-click.

3. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
4. In the left pane, click Installation.
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11.
12.

13.
14,
15.
16.

17.
18.
19.
20.
21.
22.

23.
24.
25.
26.

27.

28.
29.

Click New installation or add features to an existing installation.

At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant warnings,
click OK.

Select the Enter the product key radio button, and enter the product key. Click Next.

Click the checkbox to accept the license terms, and click Next.

Click Install to install the setup support files.

. If there are no failures displayed, click Next. You may see a Computer domain controller warning and a Windows

Firewall warning. For now, ignore these.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select Database Engine Services, Full-Text Search, Client Tools Connectivity,
Client Tools Backwards Compatibility, Management Tools —Basic, and Management Tools — Complete. Click Next.
At the Installation Rules screen, click Next once the check completes.

At the Instance configuration screen, leave the default selection of default instance, and click Next.

At the Disk space requirements screen, click Next.

At the Server configuration screen, choose NT AUTHORITY\SYSTEM for SQL Server Agent, and choose NT
AUTHORITY\SYSTEM for SQL Server Database Engine. Click Next.

At the Database Engine Configuration screen, select Mixed Mode.

Enter and confirm a password for the system administrator account.

Click Add Current user. This may take several seconds.

Click Next.

At the Error and usage reporting screen, click Next.

At the Installation Configuration rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Next.

Click Close.

Place the DVD Store backup file you prepared in the default location for SQL Server: C:\Program Files\Microsoft
SQL Server\MSSQL10.MSSQLSERVER\MSSQL\Backup.

Click Start=>All Programs—>Microsoft SQL Server 2008 R2-> Configuration Tools, and click SQL Server
Configuration Manager.

Expand SQL Server Network Configuration, and click Protocols for MSSQLSERVER.

Right-click TCP/IP, and select Enable.

Installing Microsoft Dynamics GP

1.
2.

4.

Log into Windows as a user with system administrator privileges.

Double-click the Setup.exe file to open the Microsoft Dynamics GP installation window from the Microsoft
Dynamics GP2010 installation media.

If one or more of the following components isn’t installed, the Microsoft Dynamics GP 2010 Bootstrapper Setup
window opens to install the missing component or components.

Microsoft Windows Installer 4.5

Microsoft .NET Framework 3.5 SP1
Microsoft SQL Server Native Client 10.0
Dexterity Shared Components 11.0
Microsoft Application Error Reporting 11.0
Open XML SDK 2.0 for Microsoft Office
Microsoft Lync 2010 SDK Runtime

Click Microsoft Dynamics GP.
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Select the Create new instance option, enter a name for the new instance, and click Next.

Select United States in the Country/Region Selection window,and click Next.

Accept the software license agreement, and click Next.

Select the features in the Select Features window, and click Next.

Accept the default installation folder,and click Next.

10. To set up an ODBC data source, enter the name you assigned to the SQL Server when you installed Microsoft
SQL Server, and click Next.

11. Click Install in the Install Program window.

12. Click Exit in the Installation Complete window.

13. Before you start Microsoft Dynamics GP Utilities, check for and install current service pack for Microsoft
Dynamics GP 2010.

Setting up Microsoft Dynamics GP 2010 using Microsoft Dynamics GP Utilities

1. Start Microsoft Dynamics GP Utilities (Start—=>Programs—>Microsoft Dynamics—>GP 2010->GP Utilities).

2. Verify your server name, enter a system administrator user ID and password in the Welcome to Microsoft
Dynamics GP Utilities window, and click OK.

3. The Additional Tasks window opens. In the Additional Tasks window, you can choose to do the following:

Lo N,

add sample data

create a company

remove SOP message and Invoicing message
update modified forms and reports
synchronize forms and reports dictionaries
start Microsoft Dynamics GP, or

end the installation

4. |If you select a task, click Process; otherwise, click Exit.

Creating a company

1. Select the Create a company option in the Additional Tasks window, and click Process.

In the Create Company window, enter a company ID and name, and select Additional options.

Click Next.

In the Database Setup window, select a default location for new files that will be created.

The Confirmation window appears. Confirm your selections. If the selections are correct, click Finish.

The Server Installation Progress window appears, showing progress as tables loaded.

In the Business Intelligence Reports Setup window, select the business intelligence components to deploy. Click
Next. The window that opens depends on the components selected.

Leave the components unmarked and click Next. The Company Setup Options window appears, where you can do
one of the following:

NoubkwnN
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® selectto use a wizard to migrate data from QuickBooks or Peachtree
® use a wizard to enter basic configuration options, or
¢ configure the company later using the Setup Checklist window in Microsoft Dynamics GP

9. Click Next. If you decided to configure your company later, the Additional Tasks window reappears. You can
click Create a company to set up a second company, start Microsoft Dynamics GP, or Exit.

10. If you decided to use a wizard to migrate or configure your company data, the Rapid Migration Tool or the Rapid
Configuration Tool starts.
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Setting up the Hyper-V host servers

We used the BIOS RAID configuration utility to create RAID 1 partitions on the Dell PowerEdge R410 servers for
the operating system. Following the operating system installation, we installed all important Windows updates as of
9/30/2011. We also disabled Windows Firewall on all servers and assigned IP addresses to the NICs.

Installing Windows Server 2008 R2

1. Insert the installation DVD for Windows Server 2008 R2 into the DVD drive.
2. Choose the language, time and currency, and keyboard input. Click Next.

3. Click Install Now.

4. Choose Windows Server 2008 R2 Enterprise (Full Installation). Click Next.
5. Accept the license terms, and click Next.

6. Click Custom.

7. Click the Disk, and click Drive options (advanced).

8. Click New—>Apply—>Format, and click Next.

9. After the installation completes, click OK to set the Administrator password.
10. Enter the administrator password twice, and click OK.

11. Click Start, type change power-saving settings and press Enter.
12. Click Change plan settings.

13. Change the Turn off the display drop-down menu to Never.

14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

Adding the Hyper-V role

=

Open Server Manager, and click Roles.

Click Add Roles.

On the Before You Begin page, check the Skip this page by default box, and click Next.
Select Hyper-V, and click Next.

On the Hyper-V Introduction page, click Next.

On the Create Virtual Networks page, click Next.

Confirm installation selections, and click Install.

Once the installation is complete, click Close.

When the system prompts a restart, click Yes.

10 Allow the system to fully reboot, and log in using the administrator credentials.

11. Once the desktop loads, the Hyper-V Installation Results window will finish the installation.
12. Click Close. The Hyper-V role will now be available in Server Manager under Roles.

©ENOU AW

Installing the failover clustering feature on the Hyper-V host servers

1. Open Server Manager, and click Features.

2. Click Add Features.

3. Select Failover Clustering, and click Next.

4. Click Install.

5. Once the new feature installation completes, click Close.

Installing the PowerVault Modular Disk Storage software

1. Insert the MD32xxi installation media.

Select Run md_launcher.exe from the AutoPlay window.

Select Install MD32xxi Storage Software in the Dell PowerVault MD32xxi Resource DVD window.
In the Choose Locale window, from the drop-down menu, select English, and click OK.

At the Dell PowerVault Modular Disk Storage Software Installation Welcome window, click Next.

vk wnN
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10.
11.
12.

Mark the option to accept the terms of the License Agreement, and click Next.

At the Feature Selection window, from the Install Set drop-down menu, select Full (Recommended), and click
Next.

When asked if you would like to automatically start the event monitor service when the installation completes,
select No, | will manually start the event monitor, and click Next.

When asked if you would like to automatically run the Modular Disk Configuration Utility the first time the
system is rebooted, select Yes (Recommended), and click Next.

Accept the default installation location, and click Next.

Review the Installation Summary, and click Install.

Restart the system by clicking Done.

Configuring the Modular Disk Array using the Modular Disk Configuration Utility

1.
2.
3.

4

10.
11.

12.
13.
14.
15.
16.
17.

The Modular Disk Configuration Utility automatically launches when the system restarts (see step 9, above).
Mark the option to Configure Modular Disk Storage Array at the Configuration Task window, and click Next.
Mark the following options in the Discovering storage arrays window, and then click Next:

Manual

Dual Controller (Duplex)

IPv4

Accept the pre-populated IP addresses for Controller 0 and 1

Mark the unnamed storage array as the array to configure at the Select Storage Array window, and click Next.
Enter a name for the Storage array, set the password, and click Next.

Select IPv4 as the IP configuration method for the management ports, and mark Specify configuration manually
in the Management Port Configuration window. Click Next.

Enter the IP address, Subnet mask, and Gateway in the Controller 0 Management port configuration window,
and click Next. For our testing, we used the IP 192.168.1.31.

Enter the IP address, Subnet mask, and Gateway in the Controller 1 Management port configuration window,
and click Next. For our testing, we used the IP 192.168.1.32.

Select IPv4 and IPv6 as the IP protocols used by the iSCSI ports.

Mark Specify configuration manually for IPv4, and Obtain configuration automatically for IPv6, and click Next.
Accept the pre-populated values in the next 8 iSCSI Port Configuration Windows:

Controller OIN O
Controller 0 IN 1
Controller 0 IN 2
Controller 0 IN 3
Controller 1IN O
Controller 1IN 1
Controller 1IN 2
Controller 1IN 3

When asked if you want to set up or modify the Target CHAP configuration, select No.

Review the summary information for the storage array you just configured, and click Apply.

When asked if you want to configure another storage array, select No, and click Next.

When asked if you want to configure connectivity for this host’s iSCSl initiators, select Yes, and click Next.
Select the storage array you just configured, and click Next.

Do not enter any information in the CHAP Configuration window, and click Next.
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18.

19.

20.
21.

Select the iSCSI ports for Controller 0, mark the IPv4 IP address for each iSCSI Port, and verify that the pre-
entered Host address for each iSCSI Port for Controller 0 is correct. Click Next.

Select the iSCSI ports for Controller 1, select the IPv4 IP address for each iSCSI Port, and verify that the pre-
entered Host address for each iSCSI Port for Controller 1 is correct. Click Next.

When asked if you want to connect the initiator to another storage array, select No, and click Next.

Click Finish to exit.

Configuring the second host using the Modular Disk Configuration Utility

You will need to install the PowerVault Modular Disk Storage Software as outlined above on the second Hyper-V

host before completing these steps.

1.

w

9.
10.

Start the Modular Disk Configuration Utility (Start—=>Programs—> Dell Modular Disk Configuration
Utility=>Modular Disk Configuration Utility).

At the Welcome Window, click Next.

Select the option to Configure Host in the Configuration Task window, and click Next.

Select Automatic in the Discover Storage Arrays window to select a method of discovering the storage arrays,
and click Next.

Select the storage array created in the previous section, and click Next.

Do not enter any information in the CHAP Configuration window, and click Next.

Select the iSCSI ports for Controller 0, mark the IPv4 IP address for each iSCSI Port, and verify that the pre-
entered Host address for each iSCSI Port for Controller 0 is correct. Click Next.

Select the iSCSI ports for Controller 1, mark the IPv4 IP address for each iSCSI Port, and verify that the pre-
entered Host address for each iSCSI Port for Controller 0 is correct. Click Next.

Select No when asked if you want to connect the initiator to another storage array, and click Next.

Click Finish to exit.

Creating the disk groups and volumes using the PowerVault Modular Disk Storage Manager

1.

7.
8.
9.

10.

11.

Start the Modular Disk Storage Manager (Start—>Programs—>Dell>MD Storage Manager—>Modular Disk
Storage Manager).

Select the Logical tab to view the Storage Array created above.

Right-click the Total Unconfigured Capacity in the left panel of the Storage Manager, and select Create Disk
Group.

The Create Disk Group wizard will open. Click Next to start the wizard.

Enter a name in the Disk group name field, and Select Manual (Advanced) from the Physical Disk selection
choices.

Choose a RAID level from the RAID level drop-down menu, add physical disks by selecting two at a time and
clicking the Add button, and click the Calculate Capacity button. For our testing, we selected RAID 10.

Click Next after calculating the disk group capacity.

Enter the storage array password, and click OK to create the disk group.

When asked if you would like to create a virtual disk, click Yes.

The Create Virtual Disk wizard opens. Click Next to start the wizard.

Create the virtual disks as follows:

Set the New virtual disk capacity.

Enter the Virtual Disk name.

Select Use recommended settings.

Click Finish to create the virtual disk.

Click Yes when asked if you want to create another virtual disk.

®oo oo
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f. Repeat this process to create the remaining virtual disks as needed. For our testing, we created the
following virtual disks:

i. VirtualMachinel (100GB)
ii. VirtualMachine2 (100GB)
iii. VirtualMachine3 (100GB)
iv. VirtualMachine4 (100GB)
v. VirtualMachine5 (100GB)
vi. VirtualMachine6 (100GB)

vii. SharePoint (300GB)

viii. Exchange (300GB)
ix. Exchangelog (75GB)
X. SQlLData (300GB)
xi. SQlLog (75GB)

xii. DiskWitness (10GB)

Defining a host group using the PowerVault Modular Disk Storage Manager

Before completing this section, you will need to have configured both of your Hyper-V host servers using the

PowerVault Modular Disk Configuration Utility.

1.

vk wn
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10.

11.

12.

13.

Start the Modular Disk Storage Manager (Start=>Programs—>Dell>MD Storage Manager—>Modular Disk Storage

Manager).

Select the Mappings tab to view the Storage Array created above.
Right-click the DefaultGroup, and choose Define=>Host Group.
The Define Disk Group wizard will open.

Enter an appropriate name, such as HyperVHosts, into the Provide a host group name field, select both Hyper-V

host servers, click Add to add the hosts to the HyperVHosts group, and click OK.

Select DiskWitness from the list of Virtual Disks, and 0 from the Logical unit number (LUN) field, and click Add.
Select VirtualMachinel from the list of Virtual Disks, and 1 from the Logical unit number (LUN) field, and click
Add.

Select VirtualMachine2 from the list of Virtual Disks, and 2 from the Logical unit number (LUN) field, and click
Add.

Select VirtualMachine3 from the list of Virtual Disks, and 3 from the Logical unit number (LUN) field, and click
Add.

Select VirtualMachine4 from the list of Virtual Disks, and 4 from the Logical unit number (LUN) field, and click
Add.

Select VirtualMachine5 from the list of Virtual Disks, and 5 from the Logical unit number (LUN) field, and click
Add.

Select VirtualMachine6 from the list of Virtual Disks, and 6 from the Logical unit number (LUN) field, and click
Add.

Click Close.

Teaming the Public network adapters

ok wNRE

Open the Network Connections Control Panel (Start=>Type View Network Connections).

Right-click one of the Public network adapters, and choose Properties.

Click Configure, and select the Teaming tab from the adapter properties window.

Mark Team this adapter with other adapters, and click New Team.

Enter Public as the name for the team, and click Next.

Select the Public-1 and Public-2 adapters from the list of adapters listed in the New Team Wizard window.
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10.

Select Adaptive Load Balancing from the list of team types, and click Next.
Click Finish.

Click OK to close the TEAM: Public properties window.

Click OK to close the adapter properties window opened in step 2.

Preparing the failover cluster

Complete the following steps on both Hyper-V host servers:

Creating a self-signed certificate

=
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Click Start=>Run.

Type mmc, and click OK.

When the console opens, click File=>Add/Remove Snap-in...
Under Available snap-ins, select Certificates, and click Add.

Select Computer account, and click Next.

Select Local computer, and click Finish.

At the Add or Remove Snap-ins window, click OK.

On the left side, expand Certificates (Local Computer).

Right-click Personal, and click All Tasks—=>Request New Certificate.

. On the Before You Begin page, click Next.

. On the Select Certificate Enrollment Policy page, click Active Directory Enrollment Policy, and click Next.

. Check the Computer box, and click Enroll.

. Once the certificate installation completes, click Finish. The new certificate will now be listed under Certificates

(Local Computer)—>Personal—=> Certificates.

Installing Dell OpenManage Server Administrator 6.5

1.
2.
3.

12.
13.

Insert the installation disk for Dell OpenManage Server Administrator into the DVD drive.

When the AutoPlay window appears, click Run autorun.exe.

When the Dell OpenManage Install window appears, click Install.

The install wizard scans for prerequisites.

If a Remote Enablement warning is listed, click the link to configure HTTPs Listener Windows Remote
Management.

When the Are you sure you want to configure HTTPs Listener Windows Remote Management prompt appears,
click Yes.

When the configuration tool completes, click Rescan Dependencies.

When the scan completes, click Server Administrator.

At the Welcome to the Install Wizard for Dell OpenManage Server Administrator screen, click Next.
Accept the license agreement, and click Next.

. At the Setup Type screen, select Custom, and click Next.
. At the Custom Setup screen, click Server Instrumentation—>Remote Enablement->This feature will be installed

on the local hard drive, and click Next.
At the Ready to Install the Program screen, click Install.
Once the installation completes, click Finish.

Installing the failover clustering feature on the Hyper-V host servers

1.
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Open Server Manager, and click Features.

Click Add Features.

Select Failover Clustering, and click Next.

Click Install.

Once the new feature installation completes, click Close.
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Complete the following steps on only one of the Hyper-V host servers:

Running the Validate a Configuration Wizard

1.

vk wn

Open Server Manager.

Expand Features, and select Failover Cluster Manager.

Click Validate a Configuration...

On the Before You Begin page, check the Do not show this page again box, and click Next.

At the Select Servers page, type the name of each Hyper-V host server, and click Add. After adding both servers,
click Next.

On the Testing Options page, select Run all tests (recommended), and click Next.

On the Confirmation page, click Next to begin running the validation tests.

Once the validation tests complete successfully, click Finish.

Creating and configuring the cluster

Complete the following steps on only one of the Hyper-V host servers:

Open Server Manager.

Expand Features, and select Failover Cluster Manager.

Click Create a Cluster...

On the Before You Begin page, check the Do not show this page again box, and click Next.

On the Select Servers page, type the name of each Hyper-V host server and click Add. After adding both servers,
click Next.

On the Access Point for Administering the Cluster page, type DellCluster as the cluster name.

Select a valid network, enter the desired IP address, and click Next.

On the Confirmation page, click Next.

Once the new cluster is created and configured, click Finish.

. The new cluster now appears under Server Manager—> Features—=> Failover Cluster Manager.

. Select the newly created cluster.

. Click Enable Cluster Shared Volumes...

. Read the notice window that appears, check the | have read the above notice box, and click OK.

. On the left side of the Server Manager window, expand the new cluster, and click Cluster Shared Volumes.

. Click Add storage.

. Select the desired disks, and click OK to add the disks to the cluster.

. Once the Add storage task completes, the added disks will now be listed on the main page for Cluster Shared

Volumes.

. Expand Networks in the left pane, right-click on the first cluster network in the center pane, and click Properties.
. Determine, based on the listed subnet identifying the network type, whether each network will allow cluster

network communication and whether clients will be able to connect through the network. For example, using
our sample IP scheme, the subnets 192.168.130.0, 192.168.131.0, 192.168.132.0, and 192.168.133.0 are our
iSCSI network, so we selected Do not allow cluster network communication on this network for these.

Configuring the networks for cluster access

Next, we will designate the Private/CSV network as the preferred network for CSV communication.

Click Start->Administrative Tools=>Windows PowerShell Modules.

Type Get-ClusterNetwork | ft Name, Metric, AutoMetric, Role and press Enter to view
the current preferred network assignments.

Type (Get-ClusterNetwork “Cluster Network 2”) .Metric = 900, where “Cluster Network 2”
is the Private/CSV Network, and press Enter to set it as the preferred network. Setting the Metric to a lower
value than the other networks, in this case a value of 900, will make it the preferred network for CSV
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communication. To confirm the change, repeat step 2 and verify that Cluster Network 2 now has a Metric value
of 900. For more information, see http://technet.microsoft.com/en-us/library/ff182335(WS.10).aspx.
4. Close the PowerShell Module window.

Creating the virtual network switches
Repeat these steps on both hyper-v hosts.

1. Click Start=>Administrative Tools=>Hyper-V Manager.

2. Ensure that New virtual network is highlighted in the left pane, and External is highlighted in the right pane, and
click Add.

3. For the name, enter an appropriate name. For our testing we created three virtual switches, “virtualswitch” for
the network traffic one, “iSCSI1” for the first iSCSI virtual switch, and “iSCSI2” for the second iSCSI virtual switch.
Be sure to use the same name for each of the virtual network switches on the other Hyper-V host.

4. For connection type, select the External radio button, use the drop-down menu to select the appropriate
physical adapter, ensure that the Allow management operating system to share this network adapter checkbox
is selected, and click Apply.

5. When the warning dialogue box appears, click OK.

6. Repeat steps 2 through 5 twice to create the additional virtual switches, and click OK.

7. Repeat steps 2 through 6 for the second Hyper-V host, ensuring that you use the same virtual network names.

Configuring the management server

We set up our management server with a copy of Windows Server 2008 R2 Enterprise Edition, applied an IP
address, and joined it to the domain.
Creating the virtual machine for the management server

1. Open Server Manager.

2. Expand the Failover Cluster Manager tree, and select Services and applications.

3. Right-click Virtual Machines..., select New Virtual Machine, and select the first Hyper-V host machine.

4. Inthe Before You Begin window, click Next.

5. Enter Management-Server into the Name field of the Specify Name and Location window.

6. Select Store the virtual machine in a different location, click the Browse button, browse to
C:\ClusterStorage\Volume1, and click Select Folder.

7. Click Next.

8. Enter 204 8MB (2GB) as the amount of memory to allocate to this virtual machine, and click Next.

9. Select the connection named VirtualSwitch you created in the Creating the virtual network using the Microsoft
Hyper-V Manager section, above, as the network adapter.

10. Accept the defaults for the name and location in the Connect Virtual Hard Disk window, enter 1 00GB for the
size, and click Next.

11. In the Completing the New Virtual Server Machine Wizard, click Finish.

12. Review the summary of the virtual machine to verify you successfully created the Management Server virtual
machine, and click Finish.

13. Start the Hyper-V Manger, right-click the Management Server virtual machine you just created, and click
Connect.

14. Install and patch Windows Server 2008 R2 Enterprise SP1.

Creating a self-signed certificate

1. Click Start=>Run.

2. Type mmc, and click OK.

3. When the console opens, click File=>Add/Remove Snap-in...
4. Under Available snap-ins, select Certificates, and click Add.
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Select Computer account, and click Next.

Select Local computer, and click Finish.

At the Add or Remove Snap-ins window, click OK.

On the left side, expand Certificates (Local Computer).

Right-click Personal, and click All Tasks—=>Request New Certificate.

. On the Before You Begin page, click Next.

. On the Select Certificate Enrollment Policy page, click Active Directory Enrollment Policy, and click Next.

. Check the Computer box, and click Enroll.

. Once the certificate installation completes, click Finish. The new certificate will now be listed under Certificates

(Local Computer)—>Personal—=> Certificates.

Installing Dell OpenManage Server Administrator 6.5

1.
2.
3.

12.
13.

Insert the installation disk for Dell OpenManage Server Administrator into the DVD drive.

When the AutoPlay window appears, click Run autorun.exe.

When the Dell OpenManage Install window appears, click Install.

The install wizard scans for prerequisites.

If a Remote Enablement warning is listed, click the link to configure HTTPs Listener Windows Remote
Management.

When the Are you sure you want to configure HTTPs Listener Windows Remote Management prompt appears,
click Yes.

When the configuration tool completes, click Rescan Dependencies.

When the scan completes, click Server Administrator.

At the Welcome to the Install Wizard for Dell OpenManage Server Administrator screen, click Next.
Accept the license agreement, and click Next.

. At the Setup Type screen, select Custom, and click Next.
. At the Custom Setup screen, click Server Instrumentation=>Remote Enablement—>This feature will be installed

on the local hard drive, and click Next.
At the Ready to Install the Program screen, Click Install.
Once the installation completes, click Finish.

Installing Hyper-V Tools and failover clustering tools

1.
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Open Server Manager, and click Features.

Click Add Features.

On the Select Features page, expand Role Administration Tools, and select Hyper-V Tools.
Expand Feature Administration Tools, and select Failover Clustering Tools.

Click Next.

On the Confirm Installation Selections page, click Install.

Once the installation is complete, click Close.

Installing Systems Center Essentials 2010

1.

Insert the System Center Essentials installation DVD into the host server DVD drive and capture it to the
management server VM by clicking Media - Capture in the VM window and selecting the correct drive letter of
the host DVD drive.

When the AutoPlay window appears, click Run setupSCE.exe.

At the System Center Essentials 2010 Setup window, check the Download the latest updates to System Center
Essentials 2010 during setup box, and click Install.

On the Product registration information page, enter a name, an organization, and your product key, and click
Next.

When prompted, install .NET Framework 3.5 SP1.
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10.
11.
12.

13.
14,
15.
16.

17.

At the license agreement, check the | have read, understood, and agree with the terms of the license agreement
box, and click Next.

On the Select components to install page, ensure that all components are selected, and click Next.

The wizard will then check the environment for prerequisite hardware and software. Review and correct any
prerequisite warnings, and click Next.

On the Setup will install these missing software prerequisites page, select Install Internet Information Services
(11S) and Install SQL Server 2008 SP1 on this computer now, and click Next.

When all prerequisite installations complete successfully, click Next.

On the Where should System Center Essentials files be located? page, click Next.

On the Where should Virtualization Management data be located? page, accept the default location, and click
Next.

On the Provide management account credentials page, enter the administrator user name and password, enter
the proper domain name, and click Test.

When the test completes, click Next.

On the Help improve System Center Essentials page, select No for all three items, and click Next.

On the Ready to install System Center Essentials page, review the Essentials Server and Essentials Reporting
settings, and click Install.

When the installation completes successfully, check the Open the System Center Essentials console when this
wizard closes box, and click Close.

Configuring Systems Center Essentials 2010

12.
13.
14.
15.

16.
17.
18.

On the Get Started page, click Start.

On the Policy Type page, select Yes, and click Next.

On the Firewall Exceptions page, select Yes, create Windows Firewall exceptions (recommended), and click Next.
On the Configure Remote Assistance page, select No, do not enable Remote Assistance, and click Next.

On the Computer Discovery page, select Yes.

Select Automatically discover and manage all computers, and click Next. Select No, we will discover computers
using the computer and device management wizard.

On the E-mail Notifications page, select No, | will set up notifications later, and click Next.

On the Proxy Server page, select No, and click Synchronize.

Once the synchronization is complete, click Next.

. On the Monitoring Configuration page, leave default selections, and click Next.
. On the Error Monitoring page, select Yes, collect application errors (recommended), enter a valid directory for

the Error reporting upload location, and click Next.

On the Configure Error Forwarding page, click Next.

On the Microsoft Updates page, select Automatically (recommended), and click Next.

On the Update Languages page, select Yes (recommended), and click Next.

On the Update Classifications page, select Download only critical, security, and service pack updates from
Microsoft (recommended), and click Next.

On the Update Deployment page, leave the default selections, and click Next.

On the Summary page, review the configuration, and click Configure.

Once the configuration completes, check the Start discovering computers to manage when this wizard closes,
and click Close. Allow the SCE console to install management agents on the discovered computers before
proceeding.

Adding the failover cluster as a virtual machine host in SCE 2010

1.
2.

Open System Center Essentials 2010.
On the left-hand side, click Computers.
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In the Computer Overview pane, click Designate a Host under Virtualization.

On the Select a Computer screen, select the first virtualization host.

Click Next.

Enter the administrator credentials and domain.

Click Designate.

When the validation prompt appears, click OK.

At the Network Configuration screen, select to use the existing network configurations, and click Next.

At the Completion screen, check the When the wizard closes, take me to view the new host box, and click Close.

Importing the Dell PRO Enabled Management Pack into SCE 2010

1.
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Download the Dell PRO Pack 2.0 from
http://support.us.dell.com/support/downloads/download.aspx?c=us&cs=555&I|=en&s=biz&releaseid=R252410
&formatcnt=1&libid=0&typeid=-1&dateid=-1&formatid=-1&fileid=369241.

Double-click the downloaded file.

When the Open File — Security Warning window appears, click Run.

At the Dell PRO Enabled Management Pack window, click OK.

Enter a location for the unzipped file, and click Unzip.

When the unzip process is complete, click OK.

Open Systems Center Essentials.

When the System Center Essentials console appears, click Administration on the left side.
Under Tasks, click Import Management Packs...

. On the Select Management Pack page, click Add—=>Add from disk...
. At the Online Catalog Connection prompt, click No.

. Browse to the unzipped Dell PRO Pack, and click Open.

. Once the Dell PRO Pack has been added, click Install.

. At the System Center Essentials security prompt, click Yes.

15.

Once the management pack is successfully imported, click Close.

Configuring the Live Migration networks for the virtual machines

1.
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No

Click Start->Administrative Tools—> Failover Cluster Manager.

Click Manage a Cluster.

Enter the cluster name, and click OK.

Expand the cluster name, services and applications, and click SCVMM VM resources for the first virtual machine.
In the center pane, right-click SCVMM <virtualmachinename>, and click Properties, where
<virtualmachinename> is the name of your VM.

Click the Network for live migration tab.

Use the Up and Down buttons to order the networks by priority, with the dedicated Live Migration network first,
followed by the Private/CSV network, then the Public network, and verify that the iSCSI network is disabled for
live migration. Click OK.

This should automatically set the live migration priorities for all virtual machines.

Migrating a physical server to a virtual server

1.
2.

Start System Center Essentials on the management server.

Highlight the physical server you want to virtualize in the list of servers in the domain, and click Convert to
Virtual Machine from the list of choices in the right panel.

In the Before you begin window, click Next.
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4. Enter the domain administrator credentials, select the Domain from the Domain drop-down menu, and click
Next.

5. Review the configuration recommended based on the source computer, and click Next.

6. Review the volume configuration, select Online or Offline conversion, and click Next. For our testing, we
selected the Online conversion.

7. Select a host for this virtual machine, and click Next.

8. Select a destination folder within the cluster shared volumes for the virtual disk, and click OK.

9. Enter a name for the virtual machine you are creating, and click Next.

10. Review the details of the virtual machine, select Turn off source machine after conversion, and click Create.
11. When the conversion process completes, a window stating New ‘VirtualMachine’ has been created successfully.
Click Close in this window.
12. Review any warnings presented at this point, and click Close.
Creating virtual network adapters
Perform this step on any new virtual machine or P2V conversion to create a virtual NIC to connect to the public
network. If you are attaching additional storage volumes via virtual iSCSI adapters (e.g., SQL database and log volumes,
Exchange database and log volumes, SharePoint data volumes), you will need to create additional network adapters
attached to the iSCSI virtual switches.
1. Click Start=>Administrative Tools=>Hyper-V Manager.
2. Right-click the appropriate VM, and shut it down.
3. Right-click the VM, and select Settings...
4. Ensure that Add Hardware is selected in the left pane and that Network Adapter is selected in the right pane,
and click Add.

5. Under Network, use the drop-down menu to select the appropriate virtual network switch, and click Apply. Click
OK.

Mapping volumes to the VMs
Before completing the following steps, boot the VMs, assign IP addresses to the NICs, install the Dell PowerVault
MD32xxi software, and run the Dell PowerVault Modular Disk Configuration Utility to configure the VM as a host.
1. Start the Modular Disk Storage Manager (Start—>Programs—> Dell=>MD Storage Manager—>Modular Disk
Storage Manager).
2. Select the Mappings tab to view the Storage Array created above.
3. Right-click the appropriate volume under undefined mappings, and click Define Additional Mapping...
4. Use the drop-down menu to select the appropriate VM host, select the volume you wish to map, and click Add.
Repeat to add any additional volumes to this host.
5. When you are finished, click Close.
6. Click Finish.
Installing and configuring the Exchange 2010 mail test client (LoadGen)
To create the mail client, you must install several software components. Before following these instructions,
make sure to statically assign an IP address for the client, and to then plug that port into the system under test. This
allows the client to join the Active Directory domain. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition

1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.
2. Atthe Language Selection Screen, click Next.

3. Click Install Now.

4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.
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5. Click the I accept the license terms check box, and click Next.

6. Click Custom.

7. Click Next.

8. At the User’s password must be changed before logging on warning screen, click OK.

9. Enter the desired password for the administrator in both fields, and click the arrow to continue.

10. At the Your password has been changed screen, click OK.

11. Click Start, type change power-saving settings and press Enter.

12. Click Change plan settings.

13. Change the Turn off the display drop-down menu to Never.

14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization windows.

To set up this server, we had to install several additional software components. The following subsections detail
the necessary installation processes.

Joining the domain

1. Select Start->Control Panel>Network Connections—>Local Area Connection.

2. Click Properties.

3. Highlight Internet Protocol (TCP/IP), and click Properties.

4. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the

Preferred DNS server field. Click OK.

Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.

7. Inthe Computer Name Changes window, under the Member of section, select the Domain radial box, and type
cezanne.com

8. Select OK to start joining the domain.

9. When the window appears asking for a person qualified on the domain, type Tester as the username and
Passwordl as the password.

10. At the welcome pop-up window and the window warning that you must reset the computer for the changes to
take effect, click OK.

11. At the System Properties window, click OK.

12. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

o v

Installing Internet Information Services

=

Click Start=>Administrative Tools—>Server Manager.
On the left-side pane, click Roles.
Click Add Roles.
Click the Application Server check box.
When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next.
Click Next.
At the Select Role Services page for Application Server, click the Web Server (11S) Support check box.
Click Next.
. Click Next.
. At the Select Role Services page for Web Server (l1S), click IS 6 Management Compatibility, ASP, and CGI check
boxes; and click Next.
. Click Install.
. Click Close.
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Installing Load Generator

Download and install Load Generator using all defaults.

Preparing Load Generator

1.
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o

9.

10.
11.
12.
13.
14.
15.

Log into the mail client using the tester account.

Select Start—>All Programs—>Microsoft Exchange—> Exchange Load Generator 2010.

When the Load Generator window appears, select Start a new test.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to 30 minutes.

Verify that the account name is tester.

In the Specify test settings window, type Passwordl as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

Make 75 users in each Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups window, select the plus sign to add a user group.

Change the Client Type to Outlook 2007 Cached, the Action Profile to Average, and the Mailbox size to 100MB.
Check the PreTestLogon check box, and click Continue.

Leave defaults in Remote configurations, and click Continue.

Click Save the configuration file as, and name it 75users-averagecfg.xml

After saving the configuration file, check the Initialize public store as well checkbox, and click Start the
initialization phase (recommended before running the test).

Backing up the mail database

On the Exchange server virtual machine, once you have set up the LoadGen client and created its initial mail

database, you need to back up that database so you can have clean copies for each test.

1.
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9.

10.
11.
12.

Select Start—=>All Programs—> Microsoft Exchange Server 20102 Exchange Management Console in the mail
server.

In the left pane, expand Organization Configuration and Mailbox.

In the right pane, right-click Mailbox Database, and select Dismount Database from the menu.

At the Do you want to continue? pop-up message, click Yes.

Right-click Public Folder Database, and select Dismount Database from the menu.

At the Do you want to continue? pop-up message, click Yes. The red arrow appears when you have dismounted
the Public Folder Store.

Using Windows Explorer, create a new folder: E: \backup\

With Windows Explorer, copy all database and public folder files from E:\Database to E:\backup. This process
may take several minutes.

Close Windows Explorer.

In the Exchange Management Console, right-click Mailbox Database, and select Mount Database from the menu.
Right-click the Public Folder Database, and select Mount Database from the menu.

Close the Exchange Management Console.

Preparing the SharePoint test client
Installing Microsoft Visual Studio 2010 Ultimate Edition

1.

2.
3.
4

Install Windows Server 2008 SP1 with current updates.

Double-click setup.exe

Uncheck the box for Yes, send information about my computer.

If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is
Required link. If this pop-up does not appear, skip to Step 8.
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Click Download on the appropriate Imaging component, and choose Run.
Accept the EULA, and click Next.

Close the pop-up window.

Click Next.

Accept the EULA, review the components to be installed, and click Next.
10 Choose the Full installation and location for the install, and click Install.
11. When the installation prompts you, click Restart Now.

12. Click Finish.

Setting up and running WSSDW 1.0.0.0 Beta

1. Install SharePoint Server 2010 and set up a server farm, as we detail above.
2. Visit http://sptdatapop.codeplex.com/releases/view/1141 and download the following:
e WSS Data Population Tool RunTime.zip
e WSS Data Population Tool.chm
e WSS Performance Load Tests
3. Onthe server under test, extract the contents of WSS Data Population Tool RunTime.zip. Open the WSS Data
Population Tool RunTime and WSS Data Population Tool sample folders and move their contents to the root of
the C: drive.
4. On the server under test, create a new blank Rich Text Document and save it as data.txt on root of the C: drive.
5. Onthe Domain controller, Under Active Directory Users and Computes, right click the domain, and select new
group. Create two groups: testgroupl and testgroup2.
6. Edit WSS Data Population Sample File on the server under test, using the following properties:

© oo N W

<setproperty NumberOfSiteCollections="100" />
<setproperty SiteNameBase="testsite" />

<setproperty NumberOfGroups="2" />

<setproperty GroupNameBase="testgroup" />

<setproperty TargetDomain="cezanne.com" />

<setproperty DomainGroupRoot="testdomaingroup" />
<setproperty DomainUserName="administrator" />
<setproperty DomainUserPassword="Passwordl" />
<setproperty DesignerGroup="design" AdminGroup="full control" />
<setproperty NumberOfDocumentLibraries="5" />
<setproperty DocumentLibraryNameBasel="testdoclib A" />
<setproperty NumberOfDocuments="10" />

<setproperty SourceFileLocation="c:\data.txt" />
<setproperty DestFile="test" />

<setproperty NumberOfFileVersions="3" />

<setproperty DocumentLibraryNameBase2="testdoclib B" />
<setproperty NumberOfLists="10" />

<setproperty ListNameBase="testlist" />

<setproperty NumberOfListItems="20" />

<setproperty webpartpath="webpartpagesfolder" />

7. Openthe command prompt and execute the script:

C:\>WSSDW.exe WSS Data Population Sample File.xml
8. Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
9. On the SharePoint test client, open the WssTransactions folder, and edit the following files:

® users.csv
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10.

11.
12.
13.

14.

15.
16.

17.
18.
19.
20.
21.
22.

username, password
cezanne.com\administrator, Paswordl

e serverUrl.csv
serverUrl
http://sharepointservername

e HierarchyManagerUsers.csv
username, password
cezanne.com\administrator, Passwordl

On the SharePoint test client, open the WssTestProject.sIn file in Visual Studio 2010 Ultimate, and delete the
FindText=mysite.aspx rule under Validation Rules for the following tests:

e WSSDispForm
e WSSHomePage
e WSSSmallDocLibAllltems

In Microsoft Visual Studio, click Add Load Test.

At the Welcome to the Create New Load Test Wizard, click Next.

Enter a name for the load test scenario and change the think time between test iterations to 180 seconds, and
click Next.

At the load Pattern settings for a load test scenario, select Step load, and enter 1 for Start user count, 20 for Step
duration, 1 for Step user count, and 75 for Maximum user count. Click Next.

Click Next at the Select a test mix model for the load test.

At the Add test to a load test scenario and edit the test mix, click Add and select the following:

e WSSDispForm

e  WSSDocHTTPFetch

e WSSHomePage

e WSSSmallDocLibAllltems

Ensure that the distribution is set to 25%, and click Next.

At the network types screen, select LAN, and click Next.

At the Browser screen, click Next.

At the Specify computers to monitor with counters sets during load test run screen, click Next.

At the Review and edit run settings for load test, enter 30 minutes for Run duration, and click Finish.
Click Run test to start the test.
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